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Supplementary Material

1. ProSoftArena Platform: Additional Details

1.1. Executable Professional Software Environment
ProSoftArena is constructed upon a realistic and interac-
tive computing framework, utilizing virtual machine (VM)
technology to host a fully functional Windows 11 operating
system managed via Docker containers. We selected Win-
dows as the primary platform given its dominance in the
professional software ecosystem, where complex, industry-
standard tools often require deep system integration and are
frequently exclusive to or most stable on this OS. The VM-
based architecture ensures an isolated and secure execution
space, preventing agents from causing irreversible damage
to the host system. Crucially, the environment leverages
snapshot functionality to enable efficient, deterministic re-
sets to a pristine state before each task, thereby guaranteeing
consistent initial conditions for every evaluation.

The environment is pre-configured with 13 core profes-
sional applications, including Adobe Illustrator, Photoshop,
ImageJ, ChemDraw, R, Excel, VSCode, NVivo, ArcGIS,
ANSYS, MultiSim, AutoCAD, and SolidWorks. These ap-
plications were rigorously selected to cover representative
workflows across 6 major disciplines and 20 specialized
subfields. To ensure a consistent and reproducible eval-
uation baseline, all software is fixed to specific versions.
Detailed specifications, including software versions and re-
lease builds, are provided in Table 6.

Beyond evaluation, this environment also serves as a
scalable training platform, enabling agents to learn and
master complex professional software usage.

1.1.1. Observation Space
The observation space O denotes the subset of the com-
puter environment state st 2 S that can be perceived
by the agent at each time step. Our environment pro-
vides multimodal observations comprising screen represen-
tations and additional computer-state signals. We evaluate
three types of screen representations: (i) pixel screenshot
image that captures the current screen content and win-
dow layout; (ii) XML-format accessibility (a11y) tree with
structured attributes (control names, bounding boxes, inter-
actable states); and (iii) Set-of-Marks (SoM) overlay that
annotates actionable elements with unique identifiers. Vi-
sual examples of these observation types are illustrated in
Table 7. Beyond the screen, we supply indirect observations
including clipboard contents and session metadata (titles of
all open windows and the current foreground window).

1.1.2. Action Space
We implement a unified action space A that encompasses 13
core mouse and keyboard actions covering the full spectrum
of human-computer interactions, including mouse move-
ment, clicks, dragging, keystrokes, and hotkeys.

To support strategic task management, we add three con-
trol actions: WAIT (pause to accommodate interface la-
tency), DONE (declare successful completion), and FAIL
(indicate infeasibility/abort). Together, these actions enable
agents to execute precise low-level manipulations while
managing high-level task flow, providing comprehensive
control over professional software environments. Complete
action definitions are listed in Table 8.

1.2. Agent Execution Trajectory
Given a policy ⇡, the agent predicts action at 2 A at each
time step t based on the goal g and current observation
ot 2 O. The professional application then executes at in-
side the VM and updates the state st to st+1. Subsequently,
the agent obtains an updated observation ot+1 reflecting
the new environment state st+1. The process repeats until
the agent outputs a termination action (DONE or FAIL) or
when the maximum number of steps is reached (t > tmax).
Figure 6 visualizes representative execution trajectories of
an agent completing tasks in ProSoftArena environment.

1.3. Automated Evaluation Framework
Initial Task Environment Setup. As shown in the red
block of Figure 7, the initialization script (”config”) first
downloads the specific task file ”blank.svg” from the cloud
storage to the VM path ”C:/Users/Docker/Downloads/”. It
then executes the launch command to open Adobe Illustra-
tor and load this file. To standardize the initial context, the
script executes a series of preprocessing steps: it activates
the target window ”blank.svg”, uses Python scripts to sim-
ulate keyboard shortcuts: ’v’ to switch to the Selection Tool
and ’ctrl+alt+0’ to fit the artboard to the window. This en-
sures agents start in a consistent, ready-to-work state.
Execution-based Evaluation. Upon task completion, the
system enters the evaluation phase shown in the green block
in Figure 7. It executes the postconfig sequence to acti-
vate the Illustrator window, inject a JavaScript command via
mshta to force-save the current canvas content back to the
local disk. The system then retrieves the modified file from
the VM for verification. Finally, the execution-based eval-
uation function ”check ai l1 001” (shown in the blue block
in Figure 7) is called. This function parses the XML struc-
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Table 6. List of Professional Software, Versions, Disciplines, and Usage Descriptions in ProSoftArena.

Software Version Discipline Subfield Usage
Adobe Photoshop 26.7 Art & Design Art Digital image editing and photo retouching.

Adobe Illustrator 29.5.1 Art & Design Design Vector graphic design and layout print.

Microsoft Excel 2024 Business, Science Accounting, Management, Math Financial modeling, business intelligence, and numer-
ical analysis.

R (RGui) 4.5.0 Business, Science,
Health & Medicine Finance, Math, Public Health Statistical computing, econometric modeling, and

health policy modeling.

ImageJ 15.4 Science, Health & Medicine Biology, Diagnostics &
Laboratory Medicine Microscopic/medical image analysis, cellular quan-

tification, and diagnostics.

ChemDraw 20.0 Science, Health & Medicine Chemistry, Pharmacy Molecular structure design, chemical property analy-
sis, and drug design.

ArcGIS 10.2 Science Geography Spatial analysis, cartography, and geographical stud-
ies.

ANSYS 2024 R1 Science, Tech & Engineering Physics, Energy Power, Materials Finite element analysis (structural mechanics, thermal
dynamics) and multiphysics simulation.

Multisim 14.3 Science, Tech & Engineering Physics, Electronics Electronic circuit simulation and PCB design.

NVivo 20 v1.7.2 Humanities Social Science & Sociology Systematic coding, thematic organization, and theo-
retical analysis of qualitative data (e.g., interviews).

VSCode 1.99.3 Technology & Engineering Computer Science Integrated development environment (IDE) for pro-
gramming and software development.

AutoCAD 2026 Technology & Engineering Architecture & Engineering Technical drafting and construction documentation.

SolidWorks 2025 SP1.2 Technology & Engineering Mechanical Engineering Parametric modeling and assembly design.

ture of the retrieved SVG file and check whether a triangle
exists as the task instruction requests.

2. ProSoftArena Benchmark: Construction
Details and Data Samples

2.1. Domain and Software Coverage
We systematically investigate 6 core disciplines spanning
20 subfields and select 13 representative professional soft-
ware applications. This selection prioritizes software that is
most widely used and fundamental to executing core work-
flows within their respective domains. Figure 8 presents
representative task samples from each domain, displaying
the task instruction, initial state, and key metadata such as
difficulty and human execution baselines.
Art & Design. We consider two key subfields in this do-
main: artistic creation and visual design. For artistic cre-
ation, we include Adobe Photoshop, which professionals
use for digital image editing and photo retouching. For vi-
sual design, we incorporate Adobe Illustrator, dedicated to
vector graphic design and print layout. A sample task from
this domain is: ”Remove all the birds from the opened im-
age in Photoshop, then adjust the brightness of the image to
20 and the vibrance to 100.”
Business. We investigate three critical subfields: account-
ing, management, and finance. In accounting and man-
agement workflows, Microsoft Excel serves as the primary

tool for financial modeling and business intelligence tasks.
For advanced financial analysis, we include R, which sup-
ports statistical computing and econometric modeling. A
representative task requires: ”Add Slicers for ’Region’ and
’Sales’ to the data in range ’A1:B3’ in the opened sheet to
enable regional sales analysis.”

Science. This domain covers five core subfields: biology,
chemistry, geography, mathematics, and physics. For bi-
ology, we include ImageJ, which is widely used for mi-
croscopic image analysis and cellular quantification. In
chemistry, we incorporate ChemDraw, dedicated to molec-
ular structure design and chemical property analysis. Geo-
graphical studies are represented by ArcGIS, which serves
as the standard platform for spatial analysis and cartogra-
phy. Mathematical computing relies on Excel, employed for
numerical analysis, and R, specialized in statistical model-
ing. For physics applications, we include ANSYS for mul-
tiphysics simulation and Multisim for electronic circuit de-
sign. Representative tasks include: ”Measure the angles of
four leaf veins from top to bottom in ImageJ and export
the results to results.csv,” and ”Classify the service radius
of parks based on park levels using spatial analysis tools in
ArcGIS.”

Health & Medicine. This domain encompasses the sub-
fields of diagnostics & laboratory medicine, pharmacy, and
public health. For the first, we include ImageJ, which sup-
ports medical image analysis and diagnostic quantification.
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Table 7. Visual Examples of Different Observation Types Evaluated in ProSoftArena.

Observation Type Visual Example

Screenshot

Accessibility Tree (A11y)

Set-of-Marks (SoM)

In pharmacy, we incorporate ChemDraw, widely used for
pharmaceutical molecule analysis and drug design. Public
health research is represented by R, utilized for statistical
analysis in epidemiological studies and health policy mod-
eling. A sample task in this domain is ”Analyze the molec-
ular structure information of Acetylsalicylic acid (Aspirin)
using ChemDraw.”

Humanities & Social Science. This domain centers on
qualitative research methodologies in sociology and related
subfields. We incorporate NVivo, the premier software plat-

form in this field, which enables systematic coding, the-
matic organization, and theoretical analysis of qualitative
data such as interview transcripts and survey responses. A
representative task requires: ”Conduct Matrix Coding query
in NVivo to compare perspectives of different respondents
across various aspects of ’mental-emotional wellbeing.’”

Technology & Engineering. This domain spans six core
subfields with their respective specialized software. For
architecture and engineering, we include AutoCAD, em-
ployed for technical drafting and construction documenta-
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Table 8. Definition of the Unified Action Space, encompassing 13 core primitive actions for low-level mouse and keyboard interaction and
3 high-level control actions for strategic task management.

Action Function Description

Mouse Movement move id(id) Move cursor to a specific UI element via SoM ID.
move abs(x, y) Move cursor to absolute coordinates (x, y).

Clicking
single click() Perform a single left click.
double click() Perform a double left click.
right click() Perform a right click (context menu).

Scrolling scroll(direction) Scroll the screen in the specified direction.

Keyboard write(text) Input a text string into the active field.
press(key) Press a specific key or hotkey combination.

Clipboard
copy text(text) Copy specified text to the system clipboard.
copy image(image) Copy an image to the system clipboard.
paste() Paste content from the clipboard.

System Control open program(prog) Launch a specific professional application.
switch to app(win) Switch focus to a target application window.

Task Control
WAIT() Pause execution to accommodate interface latency.
DONE() Declare successful task completion.
FAIL() Abort task due to infeasibility or error.

Step 1-2: Select "View" and click "Layout 
View" to switch the current view to layout view.

Instruction: Please help me add a north arrow to the current map layout in ArcGIS.

Step 3-4: Select "Insert" and click "North Arrow" 
to open the "North Arrow Selector".

Step 5-6: Select one style of north arrow and click 
"OK" to finish insertion.

Step 1: Double-click "Model" under "Static 
Structural" to open the system's Mechanical model.

Instruction: Please help me add a "Total Deformation" result to the current "Static Structural analysis" system in ANSYS.

Step 2-3: Expand "Static Structural" and "right-
click Solution" to display the context menu.

Step 4-6: Choose "Insert" > "Deformation" > 
"Total" to add a Total Deformation result.

1 2 3

1 2 3

Figure 6. Qualitative Examples of Agent Trajectories. The top row shows the process of adding a north arrow in ArcGIS, involving
view switching and dialog interaction. The bottom row illustrates adding a simulation result in ANSYS through tree navigation and context
menus. Red dashed lines and blue cursors indicate mouse movements and clicks, respectively.

tion. Computer science utilizes VSCode, which provides
the integrated environment for programming and software
development. For electronics engineering, we incorpo-

rate Multisim, dedicated to circuit simulation and PCB de-
sign. For energy power and materials science, we include
ANSYS, widely used for finite element analysis including
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{
    "id": "AI_L1_001",
    "snapshot": "ai",
    "instruction": "Please help me draw a triangle in the currently opened file in Adobe Illustrator.",
    "source": "https://helpx.adobe.com/illustrator/user-guide.html",
    "config": [
      {"type": "download", "parameters": {"files": [{"url": "https://github.com/.../blank.svg", "path": 

         "C:/Users/Docker/Downloads\\blank.svg"}]}},
      {"type": "launch", "parameters": {"command": ["C:/Program Files/.../Illustrator.exe","C:/Users/Docker/Downloads/blank.svg"]}},
      {"type": "sleep", "parameters": {"seconds": 35}},
      {"type": "activate_window","parameters": {"window_name": "blank.svg”}},
      {"type": "execute" ,"parameters": {"command": ["python -c import pyautogui; pyautogui.press('v’);"]}},
      {"type": "execute","parameters": {"command": ["python -c import pyautogui; pyautogui.hotkey('ctrl','alt','0’);"]}}
    ],
    "evaluator": {
      "postconfig": [
        {"type": "activate_window","parameters": {"window_name": "blank.svg"}},
        {"type": "execute","parameters": {"command": ["mshta", "javascript:var ai=new ActiveXObject('Illustrator.Application’); 

                    ai.DoJavaScriptFile('C:\\\\save_ai.jsx');close()"]}},
        {"type": "sleep", "parameters": {"seconds": 2}},
      ],
      "func": "check_ai_l1_001",
      "result": {"type": "vm_file","path": "C:\\Users\\Docker\\Downloads\\blank.svg","dest": "AI_L1_001_output.svg"}
    }
  }

def check_ai_l1_001(svg_path):
    tree = ET.parse(svg_path)
    root = tree.getroot()
    ns = {'svg': 'http://www.w3.org/2000/svg'}
    for polygon in root.findall('.//svg:polygon', ns):
        points = polygon.get('points', '')
        coords = [float(p) for p in re.findall(r'[-+]?\d*\.\d+|\d+', points)]
        if len(coords) == 6 or (len(coords) == 8 and
           abs(coords[0]-coords[-2]) < 0.1 and abs(coords[1]-coords[-1]) < 0.1):
            return 1.0
    return 0.0

Figure 7. Initialization and Evaluation Script Example for Task ”AI L1 001” (Adobe Illustrator).

structural mechanics and thermal dynamics. Mechanical
engineering employs SolidWorks for parametric modeling
and assembly design. Representative tasks include: ”Draw
a standard outdoor badminton court and annotate the dimen-
sions in AutoCAD,” and ”Model three components of a sy-
ringe in SolidWorks: a barrel, a plunger, and a needle.”

See Table 6 for detailed software specifications, versions,
and domain mappings.

2.2. Metadata Annotation
All annotations are conducted within a standardized soft-
ware environment with fixed application versions to ensure
consistency in task execution. For each task, domain ex-
perts curate a comprehensive metadata profile comprising:
• Task ID: A unique identifier for each task.
• Instruction: A precise natural language directive speci-

fying the user goal. Instructions are rigorously formulated
to ensure the target output is unambiguous and objective.

• Context Resources: The necessary input assets to com-
plete the task (e.g., files, datasets or images).

• Task Source: The task’s provenance (e.g., manual sec-
tion, tutorial URL, or expert-authored).

• Core Operations: For higher-level tasks (L2/L3), anno-
tators explicitly map the workflow back to the atomic op-

Table 9. Metadata Annotation Example.

Metadata Field Content / Value

Task ID AI L1 001

Instruction Please help me draw a triangle in the cur-
rently opened file in Adobe Illustrator.

Context Resources blank.svg (Input file loaded at start)

Task Source Official User Guide (https://helpx.
adobe.com/illustrator/user-

guide.html)

Core Operations Shape Drawing / Polygon Tool Usage

Expected Output AI L1 001 output.svg (Must contain
a valid 3-vertex polygon)

Difficulty Easy

Human Reference • Demo: AI L1 001.mp4

• Steps: 3
• Time: 10s

erations (L1) required (e.g., ”Shape Drawing”), enabling
fine-grained capability analysis.

• Expected Output: Defines the tangible artifacts (e.g.,
saved files, exported charts) or system states used for ob-
jective evaluation.
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Art & Design
Instruction: Please help me remove all birds from the 
photo, then adjust the brightness of the image to 100.

Software: Photoshop; Subfield: Art; 
Level: L2; Difficulty: Medium;
Human Steps: 17; Human Time: 49s

Natural Science
Instruction: Measure the angles of four leaf veins 
from top to bottom in ImageJ and export the results.

Software: ImageJ; Subfield: Biology
Level: L2; Difficulty: Medium
Human Steps: 10; Human Time: 30s

Social Science
Instruction: Compare the perspectives of different 
respondents on the various aspects of "wellbeing" .

Software: Nvivo; Subfield: Sociology; 
Level: L2; Difficulty: Medium; 
Human Steps: 12; Human Time: 53s

Business
Instruction: Please help me add slicers for "Region" 
and "Sales" to the data to enable regional sales analysis.

Software: Excel; Subfield: Marketing; 
Level: L1; Difficulty: Easy; 
Human Steps: 5; Human Time: 30s

Tech & Engineering
Instruction: Help me Model three components of a 
syringe in SolidWorks: a barrel, a plunger, and a needle.

Software: Solidworks; Subfield: Mechan. 
Engineer; Level: L2; Difficulty: Hard; 
Human Steps: 55; Human Time: 10min

Health & Medicine
Instruction: Help me draw and analyze the molecular 
structure information of Acetylsalicylic acid (Aspirin).

Software: ChemDraw; Subfield: 
Pharmacy; Level: L2; Difficulty: Easy
Human Steps: 16; Human Time: 56s

Figure 8. Representative Task Samples across Six Core Domains in ProSoftArena. For each domain, we showcase a typical task
scenario including the specific natural language instruction, the initial computer state, and associated metadata.

Figure 9. Statistical Breakdown of ProSoftArena Benchmark. Left: Task distribution across Capability Levels (L1-L4) and Difficulty
ratings (Easy, Medium, Hard). Middle & Right: Detailed breakdowns of domain and software coverage for L1 (Operation Level) and L2
(Software Level) tasks, respectively.

• Difficulty & Human Baseline: Experts provide a sub-
jective difficulty rating (Easy, Medium, Hard) and record
their own execution metrics, including a standard demon-
stration video, total operation steps, and completion time,
serving as a ”Human Expert” baseline.

Table 9 presents a concrete example of these metadata
fields for an Operation Level task in Adobe Illustrator.

2.3. Quality Control
Following the data annotation phase, we implement a rigor-
ous quality control protocol to ensure the reliability and va-
lidity of the benchmark. Each task is subjected to indepen-
dent cross-validation by at least two domain experts. The
review process strictly assesses the following dimensions:
• Feasibility: Verifying that the task is technically com-
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pletable within the standardized software environment.
• Instructional Clarity: Ensuring the natural language in-

struction is detailed, specific, and unambiguous, guaran-
teeing that it leads to a unique, valid solution rather than
open-ended interpretations.

• Output Alignment: Confirming that the annotated ex-
pected output (e.g., specific files or system states) accu-
rately reflects the fulfillment of the task objective.

• Evaluability: Verifying that the task is objectively evalu-
able using our execution-based scoring criteria.

Tasks that failed to meet these standards—particularly
those with ambiguous instructions, ill-defined outputs, or
unreliable evaluation metrics—were explicitly excluded
from the final benchmark.

2.4. Statistics Breakdowns

Figure 9 visualizes the benchmark composition. The left
chart displays the distribution of tasks across capability lev-
els and difficulty ratings. The middle and right charts break
down the specific domain and software coverage for L1 and
L2 tasks, respectively. Additionally, Table 10 details a rep-
resentative Pipeline Level (L3) workflow to illustrate cross-
application complexity.

3. Experiments Setup and Extended Results

3.1. Subjective Evaluation for Creative Tasks (L4)

Unlike the deterministic tasks in L1-L3, Creative Level (L4)
tasks focus on open-ended generation where binary suc-
cess metrics are insufficient. Figure 10 presents a subjective
comparison between the outputs generated by state-of-the-
art multimodal agents and those created by human experts.
Results Analysis. The comparison reveals a profound ca-
pability gap in open-ended creative workflows. While hu-
man experts utilize these tools to produce polished and
structurally sound designs, current agents struggle signifi-
cantly to generate coherent results. As observed, the agent-
generated outputs are often structurally incomplete or even
shapeless, failing to meet basic design standards. This crit-
ical limitation stems from two primary factors:
• GUI Interaction Bottlenecks: Creative tasks require

continuous, fine-grained mouse manipulations (e.g., drag-
ging to draw curves, precise positioning of elements).
Current agents lack the high-frequency, pixel-perfect mo-
tor control required for such ”analog” interactions.

• Abstract Intent Grounding: Agents struggle to trans-
late abstract creative intentions (e.g., ”design a warm
and inviting logo”) into the concrete, multi-step execu-
tion plans required by professional software, resulting in
outputs that are functionally disjointed from the user’s
prompt.

3.2. Agent Configurations and System Prompts
For MLLM-based agents, we adopt a standardized configu-
ration with a temperature of 1.0 and top-p of 0.8 to balance
generation diversity with instruction adherence. To accom-
modate varying task complexities while preventing infinite
execution loops, we dynamically adjust the maximum step
budget (MAX STEPS): 35 steps for Operation Level (L1),
55 steps for Software and Creative Levels (L2, L4), and
100 steps for the long-horizon Pipeline Level (L3) work-
flows. The agent’s observation space integrates raw screen-
shots (with optional Set-of-Marks overlay) and the acces-
sibility trees. Table 11 presents a complete system prompt
used for the observation setting ”SoM+Screenshot+A11y”,
defining the agent’s role, operational constraints, and suc-
cess criteria, while outlining the available observation and
action spaces alongside representative examples.

3.3. Failure Case Studies
We visualize representative examples of common error
patterns in Figures 11-14, including (i) Domain & Tool
Knowledge Gaps (Figure 11) where agents lack specific
tool or domain expertise; (ii) Task Planning Errors & In-
valid Actions (Figure 12) where agents omits crucial pro-
cedures or predicts actions outside the predefined action
space; (iii) Visual Grounding Inaccuracies (Figure 13)
where agents misidentify UI elements despite generating
correct action plans; and (iv) Repeating Operations (Fig-
ure 14).
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GPT-5 HumanClaude CUA o3

Design a cute, cartoon-style 
logo for a pediatric dentistry 
clinic, incorporating sun and 
smile elements to convey 
warmth, friendliness, and 
happiness.

Design a bold, energetic-style 
logo for Built Different Brands 
(a parent company), 
incorporating fresh apple (food) 
and simple wellness icons, to 
convey excitement, positivity, 
and approachability.

Design a simple, flat-style logo 
for a marketing company, 
incorporating a lion element 
and rustic retro typography, 
with monochromatic contrast, 
to convey pride, confidence, 
and boldness.

Design a sleek, elegant-style 
logo for a fintech company 
(FinBridge Partners), 
incorporating a dynamic blue 
arc and bold typography, with 
black and blue crisp contrast, to 
convey strength, 
professionalism, and trust.

Task Instructions

Figure 10. Subjective Evaluation Results on Creative Level (L4) Tasks.

Task: Please help me set up a complete web development environment for the currently 
opened project “L2_VSCode_003” in VSCode.        Model: Qwen2.5-VL-72B-Instruct
Step: # Move the mouse to the "View" menu and click to open the dropdown menu…
# Move the mouse to the "Extensions" option in the dropdown menu…
# Use the search bar in the Extensions view to search for "Live Server”…
computer.keyboard.write("Live Server") computer.keyboard.press("enter")

(a) Tool Usage Gap (VSCode)

Task: Please help me draw an anthracene molecule in ChemDraw.         
Model: Qwen2.5-VL-72B-Instruct

Step: ```decision
# Anthracene is already drawn on the canvas; task is 
complete.
DONE
```

(b) Domain Knowledge Gap (ChemDraw)

Figure 11. Domain and Tool Knowledge Gaps. (a) The agent fails to install and launch the ”Live Server” extension in VSCode due to
a lack of specific tool knowledge. (b) The agent incorrectly constructs the anthracene molecule but hallucinates success, demonstrating a
failure to verify the chemical structure based on domain principles.
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Task: Help me use the Command Palette in VSCode to change the color theme to “Red”. 
Model: Qwen2.5-VL-72B-Instruct
Step: # Focus the Command Palette input and run the Color Theme command 
computer.mouse.move_id(id=78) computer.mouse.single_click() 
computer.keyboard.write("Preferences: Color Theme")

(a) Task Planning Error

Task: Please help me rotate the current image 90 degrees clockwise in ImageJ.
Model: GLM-4.5V
Step: For the current step, I need to click on the "Image" menu in the 
ImageJ window. The final answer is 
<|begin_of_box|>CLICK(box='[194, 66]')<|end_of_box|>

(b) Invalid Action (GLM-4.5V)

Figure 12. Task Planning Error & Predicting Invalid Actions. (a) The agent fails to clear the previously entered command before
inputting the next one due to task planning error. (b) The agent predicts an action outside the predefined action space, indicating a
limitation in instruction following capabilities.

Task: Please help me draw a triangle in the currently opened file in Adobe Illustrator.      Model: GPT-4o
Step 1: # Move to the Polygon Tool and select it
computer.mouse.move_id(id=82)  # ID for the Polygon Tool
computer.mouse.single_click()  # Click to select the tool

Step 2: # Move the mouse to the Polygon tool.
computer.mouse.move_id(id=82)
computer.mouse.single_click()

Step 3: # Move the mouse to the Polygon Tool.
computer.mouse.move_id(id=75)
computer.mouse.single_click()  # Select the Polygon Tool.

Figure 13. Visual Grounding Error. GPT-4o correctly plans to select the “Polygon tool” but fails to map this intent to the correct visual la-
bel. This grounding failure causes the agent to target incorrect element IDs, leading to the erroneous selection of adjacent primitives—such
as the ellipse, rectangle, or hexagon tools—instead of the intended polygon icon.

Task: In the currently opened worksheet in Excel, insert a blank row above row "1"; then, delete column "A" and save the workbook. Model: GPT-5
Step 2: # Click "Insert" to insert a row above the selected row
computer.mouse.move_id(id=3)
computer.mouse.single_click()

Step 2: # Click the "Insert" option to insert a new row above 
computer.mouse.move_id(id=3) 
computer.mouse.single_click()

Step 3: # Click 'Insert' to add a row above the selected row 
computer.mouse.move_id(id=3) 
computer.mouse.single_click()

Figure 14. Repeating Operation. Despite successfully inserting a row, the agent fails to recognize the state change and repeatedly executes
the same insertion command. This redundant loop exhausts the step budget, preventing the completion of subsequent task requirements.
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Table 10. Pipeline Level (L3) Task Sample. This task requires the agent to coordinate between ArcGIS and Excel to perform spatial
aggregation and statistical analysis.

TASK NAME: Street-Level Population Aggregation & Percentage Analysis (ArcGIS + Excel)

TASK OVERVIEW:
Perform spatial aggregation of residential points by street in ArcGIS to compute the total population per street, export the result as a text
table, then clean and compute population percentages in Excel. All steps must be followed strictly according to the task flow.

REQUIREMENTS:
1. Use the currently opened map: ”ArcGIS L3.mxd” (ArcMap).
2. Do not change any parameter not explicitly stated.
3. File names and paths must match exactly.

OUTPUTS TO PRODUCE:
1) C:/Users/Docker/Downloads/summary.txt
2) C:/Users/Docker/Downloads/population.xlsx

––– TASK FLOW –––
Phase 1 — ArcGIS (Aggregate by street and export)
Goal: Calculate the total population (field ”people”) for each street and export result to summary.txt.

1.1 Spatial Join
- Open ”Spatial Join” (ArcToolbox > Analysis Tools > Overlay > Spatial Join).
- Set Target Features = ”Street”; Join Features = ”Residential Point”; Join Operation = ”JOIN ONE TO ONE”; Match Option = ”IN-
TERSECT”; Check ”Keep all target features”.
- Run and wait for the spatial-join layer.
1.2 Summary Statistics
- Open ”Summary Statistics” (Analysis Tools > Statistics).
- Input Table = spatial-join result; Statistics Field = ”people” (SUM); Case field = ”street”.
- Output Table = ”C:/Users/Docker/Downloads/summary.dbf”.
1.3 Export Table as Text
- Right-click ”summary” table ! Data ! Export. Save as ”Text File” to ”C:/Users/Docker/Downloads/summary.txt”.

Phase 2 — Excel (Import, clean, compute percentages, save)
Goal: Import text file, clean data, compute statistics, and save as .xlsx.

2.1 Import & Clean
- Open Excel, import ”summary.txt” via ”Data > From Text/CSV”.
- Delete columns ”OID ” and ”FREQUENCY”. Keep ”Street” (Col A) and ”SUM people” (Col B).
- Rename ”SUM people” to ”Total Population”.
2.2 Computation
- Add Column C header ”Population Percent”.
- Row 5 (Totals): Set A5=”SUM”, B5=”=SUM(B2:B4)”.
- Calculate Percentages (Col C): C2=”=B2/$B$5”, copy down to C4. Format as Percentage (2 decimals).
- C5=”=SUM(C2:C4)” (Verification).
2.3 Save
- Save workbook as ”C:/Users/Docker/Downloads/population.xlsx”.

Strictly follow the TASK FLOW. Complete Phase 1 first, then Phase 2, in order.
Each phase counts 0.5 points (maximum 1.0).
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You are Screen Helper, a world-class reasoning engine that can complete any goal on a computer to help a user by executing
code. When you output actions, they will be executed on the user’s computer. The user has given you full and complete
permission to execute any code necessary to complete the task. In general, try to make plans with as few steps as possible.
Verify at each step whether or not you’re on track.

1. STEP BUDGET & TERMINATION
- Keep an internal step counter (start at 1). MAX STEPS = 55. Do not exceed 55 actions.
- If the task is completed, immediately output DONE. Never take extra actions after success.
- After actions that likely change views (open / save / confirm / navigation), prefer WAIT before the next decision so the UI
can settle.
- Do NOT emit FAIL merely because you approach the step budget. FAIL is only for tasks proven impossible (see below).

2. SUCCESS / DONE CRITERIA
Output DONE the moment the screenshot clearly shows success, e.g.:
- Target end-state UI appears (saved / finished confirmation, required view visible, toggle reflected).
- Save / export completed with no blocking modal (toast / indicator shown, or app returns to canvas with no prompts).
- Continuing would risk undoing or altering the achieved result.

3. WHEN TO USE FAIL (RARE & STRICT)
- Default to persistence: explore multiple reasonable paths before concluding impossibility.
- Output FAIL only if, after careful verification, the requested functionality clearly does not exist or cannot be accessed in
this app/version/session.
- Before emitting FAIL (when applicable), you should have:
1) Searched the most relevant menus / toolbars / context menus (with modest SCROLL for long lists).
2) Checked disabled / greyed options and attempted safe enabling steps (open / select / switch mode).
3) Looked for preferences/settings related to the feature.
4) Noted explicit on-screen evidence of absence / lock (edition / permission / “not supported” / feature-gated errors with no
in-app remedy).
5) Tried at least two distinct workflows (e.g., menu path vs hotkey), inserting WAIT after state-changing.
Do NOT use FAIL for mere step-budget pressure.

4. Inputs
4.1. User objective.
A text string with the user’s goal for the task, which remains constant until the task is completed.

4.2. Accessibility tree of the desktop, contains screen elements with following fields.
- tag: The type of element (e.g., textblock, button).
- name: The name or label of the element (e.g., ”Search”, ”29°C”).
- text: The visible text content, or an empty string for elements like images or icons.
- class: The class of the UI control, indicating its functionality (e.g.,
pywinauto.controls.uia controls.ButtonWrapper).
- description: A description of the control, may be empty.
- position (x, y): The top-left corner position of the element on the screen (measured in pixels).
- size (width, height): The dimensions of the element (measured in pixels).

4.3. Image of the current screen:
4.3.0 Raw screen image.
4.3.1 Annotated screen with bounding boxes drawn around the image (red bounding boxes) and icon (green bounding boxes)
elements, each tagged with a colored ID label (white font on top of a colored background box) at the bottom-right of the
element’s box.
Very important note about annotated screen image:
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- The element IDs are marked on the bottom right corner of each respective element with a white font on top of a colored
background box. Treat only these colored bottom-right labels as element IDs. Never confuse them with other numbers on
the screen (e.g., slide numbers, list indices).
- When selecting an element for interaction you should reference the colored annotated IDs, and not the other numbers that
might occur on the screen.
- When elements are close together, double-check that the ID belongs to the intended element (not a neighbor). Selecting
the wrong ID will cause the action to fail—verify before acting.
- If an element’s appearance in the annotated image is partially hidden by its ID label, you may first glance at the raw image
to get a general sense of where that element is located (for example, noticing it is the icon directly below another easily
recognizable icon). Then, use that approximate location to identify and confirm the exact colored ID in the annotated image
before taking action.
- If the intended element has no ID, fall back to use absolute coordinates as described below.

4.4. List of candidate screen elements. A list of candidate screen elements which you can interact with, each represented
with the following fields:
- ID: A unique identifier for the element.
- Type: The type of the element (e.g., image, button, icon).
- Content: The visible text content of each button / region (empty for images and icons).
- Location: The normalized location of the element on the screen (0–1), expressed as a tuple (x1, y1, x2, y2) where (x1, y1)
is the top-left corner and (x2, y2) is the bottom-right corner.

5. Outputs
Your goal is to analyze all the inputs and output the following items (in order):

# Screen content analysis:
Reasoning over the screen content. Answer the following questions:
5.1. What is actively happening on the screen?
Based on the RAW screen image, describe the screen content and ongoing action from the following perspectives (in order):
- Screen content: What is on the screen? (factually)
- Mouse: Where is the mouse? Is it selecting/hovering/focus on any element?
- Keyboard: typing or not; focused input.
- Selected / highlighted / focused elements: Is any element selected, highlighted, or focused?
- Activity: spinners / progress bars / timers / network messages.
This is crucial for determining what has been completed and the current step, preventing any repetition of already finished
actions.
5.2. Has the goal already been completed? If yes, decide ”DONE” and stop further actions.
5.3. Based on the current state, what’s your plan to complete the goal?
5.4. Based on the current state and plan, what action should be performed now on the current screen? Avoid repeating actions
that have already been executed (e.g., if a field is already selected, don’t click it again).

# Reasoning about current action step:
5.5. Output a high-level decision for this step. Choose ONE:
- DONE: If the task is completed and no further action is needed. This ends the episode.
- FAIL: Only if the task is provably impossible (feature absent/locked, unrecoverable error). This ends the episode.
- WAIT: If the screen is loading / rendering / downloading, or after a view-changing action so the UI can settle. This will
trigger a sleep delay until your next iteration.
- COMMAND: Execute the code block (see below) for the current action step. Make sure that you wrap the decision in a
block with the following format:
‘‘‘decision

# your comment about the decision

COMMAND # or DONE, FAIL, WAIT

‘‘‘
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5.6. Output a block of code that represents the action to be taken on the current screen (only if decision==COMMAND). The
code should be wrapped around a python block with the following format:
‘‘‘python

# your code here

# more code...

# last line of code

‘‘‘

5.7. Textual memory output. If you have any information that you want to store for future steps, you can output it here. This
can be useful for storing information which you plan to use later steps (e.g. a summary, description of a previous page, or a
song title which you will type or use as context later). You can either copy the information from the input textual memory,
append or write new information.
‘‘‘memory

# your memory here

# more memory...

# more memory...

‘‘‘

Note: remember that you are a multi-modal vision and text reasoning engine, and can store information on your textual
memory based on what you see and receive as text input.

6. Action Space
Below we provide further instructions about which functions are available for you to use in the Code Block.
Use ONLY these functions and parameters, otherwise your action will be considered as invalid and you will get a penalty.
You may use the ‘computer‘ Python module to complete tasks:

6.1. GUI-related functions
- computer.mouse.move id(id=78) # Moves the mouse to the center of the element with the given ID. Use this very
frequently.
- computer.mouse.move abs(x=0.22, y=0.75) # Moves the mouse to the absolute normalized position on the
screen. The top-left corner is (0, 0) and the bottom-right corner is (1, 1). Use this rarely, only if you don’t have an element
ID to interact with, since this is highly inaccurate. However this might be needed in cases such as clicking on an empty space
on the screen to start writing an email (to access the ”To” and ”Subject” fields as well as the main text body), document, or
to fill a form box which is initially just an empty space and is not associated with an ID. This might also be useful if you are
trying to paste a text or image into a particular screen location of a document, email or presentation slide.
- computer.mouse.single click() # Performs a single mouse click action at the current mouse position.
- computer.mouse.double click() # Performs a double mouse click action at the current mouse position. This
action can be useful for opening files or folders, musics, or selecting text.
- computer.mouse.right click() # Performs a right mouse click action at the current mouse position. This action
can be useful for opening context menus or other options.
- computer.mouse.scroll(dir="down") # Scrolls the screen in a particular direction (”up” or ”down”). This action
can be useful in web browsers or other scrollable interfaces.
- computer.mouse.drag(x=0.35, y=0.48) # Drags the mouse from the current position to the specified position.
This action can be useful for selecting text or moving files.

6.2. keyboard-related functions
- computer.keyboard.write("hello") # Writes the given text string
- computer.keyboard.press("enter") # Presses the enter key

6.3. OS-related functions
- computer.clipboard.copy text("text to copy") # Copies the given text to the clipboard. This can be
useful for storing information which you plan to use later
- computer.clipboard.copy image(id=19, description="already copied image about XYZ

to clipboard") # Copies the image element with the given ID to the clipboard, and stores a description of what was
copied. This can be useful for copying images to paste them somewhere else.
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- computer.clipboard.paste() # Pastes the current clipboard content. Remember to have the desired pasting loca-
tion clicked at before executing this action.
- computer.os.open program("msedge") # Opens the program with the given name (e.g., ”spotify”, ”notepad”,
”outlook”, ”msedge”, ”winword”, ”excel”, ”powerpnt”). This is the preferred method for opening a program, as it is much
more reliable than searching for the program in the taskbar, start menu, and especially over clicking an icon on the desktop.
- computer.window manager.switch to application("PowerPoint") # Switches to the foreground win-
dow application with that exact given name, which can be extracted from the ”All window names” input list

7. Examples
7.1. Example 1
User query = ”search news about ’Artificial Intelligence’”.
The current screen shows the user’s desktop.
Output:
‘‘‘python

computer.os.open program("msedge") # Open the web browser as the first thing to

do‘‘‘

7.2. ... 7.7
7.8. Example 8
User query = ”find the lyrics for this song”.
The current screen shows a Youtube page with a song called ”Free bird” playing.
Output:
‘‘‘python

computer.os.open program("msedge") # Open the web browser so that we can search for

the lyrics in the next step‘‘‘

‘‘‘memory

# The user is looking for the lyrics of the song "Free bird"‘‘‘

8. FINAL REMINDERS
- Break tasks into reliable steps; do not attempt everything in one shot.
- Prefer ID targeting via candidate list; if missing, click candidate box center; use absolute coords only as a last resort.
- If the same action does not yield results after 2 attempts, change strategy.
- Do NOT try to complete the entire task in one step. Break it down into smaller steps like the one above, and at each step
you will get a new screen and new set of elements to interact with.
- Favor efficient, reliable paths. Stop at DONE immediately upon success. Do not exceed 55 steps. Use FAIL only for proven
impossibility.

Table 11. System Prompt for MLLM Agents with SoM+Screenshot+A11y Observations.
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